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1 About GingerALE

GingerALE is used for performing meta-analyses of human brain imaging studies with published coordinates in
Talairach or MNI space. When ALE was originally developed by Peter Turkeltaub, it stood for activation
likelihood estimation (Turkeltaub et al., 2002). It has also come to mean anatomic likelihood estimate when
used in conjunction with anatomic data, such as the voxel-based morphometry (VBM) database. BrainMap
adopted GingerALE’s first methods in 2003, and since then there have been several modifications to keep the
algorithms current. Thresholding methods described in Laird et al. (2005) and Eickhoff et al. (2012) have been
added. With version 2.0, GingerALE switched ALE methods from fixed effects to random effects as well as
incorporated variable uncertainty based on subject size (Eickhoff et al., 2009). A modification to the ALE method
described by Turkeltaub et al. (2012) limits the effect of a single experiment. The full text for these publications
is available on brainmap.org/pubs.

2 Performing ALE Meta-Analyses

The random effects algorithm changed GingerALE’s focus from agreement between foci to agreement across
experiment groups. Or, if using Turkeltaub’s method of “minimizing within-group effects”, GingerALE finds
agreement across subject groups. Either way, your results are driven by your dataset’s foci as well as how they
are grouped. The foci data is read as a text file, which can be generated by hand or from a excel worksheet, or
exported from a workspace in BrainMap Sleuth. It’s critical that your input foci data uses the format GingerALE is
expecting (Fig. 1). In order to verify that your foci have been interpreted correctly, GingerALE will display the
number of foci and the number of foci groups. Warnings will also be shown if there are experiments without any
foci or if an experiment appears duplicated (has exactly the same foci).

2.1 Foci Formatting
The format for this file should be three columns

of numbers (x,y,z coordinates), separated with // Reference=Talairach
tabs or spaces. Optionally the file can start a line // Hui, 2000: Acupuncture vs. Tactile Stimulation, Increases
// Subjects=13

indicating the standard brain space. If included,

GingerALE will check that the current reference >6 -15 >0

. -59 -18 43
space matches the foci space and offer to change 59 21 21
if needed. Subsequent foci groups will be 50 18 18
separated by a line break and started with some
identifying information. Sleuth will export the // Li, 2003: Conventional Acupuncture > Rest, Activations
first author name, year, and experiment name or // Subjects=20
subject group name. Next should be the number -5.12 -82.33 10.8
of subjects for this group of foci, followed by the 23 -77.71 11.37
coordinate data. All non-coordinate data should 15.36 -62.35 7.64

45.18 15.75 15.54

be in a comment, which starts with “//”. Be sure
to include an empty line between foci in separate

o Li, 2003: Electro-Acupuncture 2 Hz > Rest
groups, but not between each individual focus // P

// Subjects=20

within the same group. 2.28 77.88 13.15

-6 -68.35 12.11
Since implementing the variable uncertainty of -56.89 -63.43 11.72
the random-effects method in Eickhoff et al. 49.74 15.21 20.97

(2009), GingerALE needs subject information for
Figure 1. Example foci data



each foci group to calculate (Fig. 2) the Full-Width
Half-Maximum (FWHM) of the Gaussian function
used to blur the foci. Larger subject sizes get a
tighter, taller Gaussian. If any foci groups are
missing subject information, GingerALE will show
a warning dialog after loading the foci file. The
analysis can continue assuming a subject size of 1.

If you used Sleuth to create a foci file from your
workspace, then there is no need to spatially
renormalize your MNI coordinates to Talairach
space (or vice versa). This conversion is done
automatically when the papers are inserted into
the BrainMap database using a transform called
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Figure 2. Subject size versus Full-Width Half Maximum

icom2tal developed by Lancaster et al. (2007). This new transform provides improved fit over the Brett
transform (mni2tal), and improves the accuracy of meta-analyses (Laird et al., 2010). For data sets that need to
be transformed, GingerALE contains all the icbom2tal transforms in Tools = Convert Foci. Please note that we no
longer use the Brett transform for conversion of coordinates from MNI space to Talairach space; however, it is
included to allow reconversion of published foci.

2.2 Single Dataset Analysis

Load your foci data into GingerALE with File & Open Foci. Once you select your foci text file, GingerALE will
read and verify your dataset with a series of checks. As previously mentioned, there are checks for mismatching
reference spaces, missing subject sizes, and empty or duplicated foci groups. There is also a warning dialog for
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Figure 3. GingerALE Interface

any foci in your dataset that are outside of the bounds of the
current mask. (For more on masks, see Fig. 7) Typically a small
percentage of foci are located outside the mask. If a large number
of foci are outside the mask, please check your foci file for errors.
If you are confident that your out-of-mask foci are correct, don’t
worry; foci outside the mask still contribute to the ALE analysis.

The main window of GingerALE (Fig. 3) will confirm the name of
your foci file, the number of foci and foci groups contained
therein, and the current reference space. Once you have loaded
your dataset and reviewed any errors or warnings, you are now
ready to choose your threshold settings and begin the calculations
of the analysis. The ALE meta-analysis calculations follow four
main steps: ALE scores, null distribution, thresholding and cluster
statistics.

ALE calculations first create a 3D image for each foci group using
the mask, the foci and a Gaussian blur with a FWHM empirically
derived from your subject size. These pre-ALE experiment-level
images are called Modeled Activation (MA) maps (Eickhoff et al.
2009). The MA maps can be calculated by finding the union
(Eickhoff et al. 2009) or the maximum (Turkeltaub et al., 2012)
across each focus’s Gaussian. Using the maximum limits the effect
of an experiment with multiple foci very near one another and is
referred to as “Non-Additive” in the preferences (Section 3.1). The
ALE image is a union of all of the MA maps.



GingerALE uses the analytical method of determining the null distribution of the ALE statistic (Eickhoff et al,
2012). This method first tallies the values in the MA maps to make histograms. Using histograms changes the
computation from voxels to equal values within a single bin. This switch also removes spatial information from
the process. The histograms are divided by the total number of voxels in a MA map to create tables of
probabilities of finding each value in a MA map. Combining the probabilities yields a table of P values for ALE
scores. The ALE image and the P value table are used to create a 3D P value image.

Now that you have a P value image, it can be used to set a significance threshold on the ALE scores. The
simplest threshold is an Uncorrected P value threshold. Any voxel where the P value image has a value over the
threshold will be set to zero. Since the Uncorrected P value method is the least conservative, we recommend
choosing a very conservative threshold, such as P < 0.001 or 0.0001. Another available method is False Discovery
Rate (FDR; Laird et al., 2005; Genovese et al., 2002), which controls the rate of false positives to less than the
chosen threshold value. GingerALE computes the FDR wusing Tom Nichol’'s algorithm (www-
personal.umich.edu/~nichols/FDR/).  This algorithm vyields two P value thresholds, depending on the
assumptions you want to make. FDR pID is the threshold assuming independence or positive dependence. FDR
pN makes no assumptions about how the data is correlated. FDR pN is more conservative option. The RII
generally uses the P value threshold returned by FDR pN and a False Discovery Rate of 0.01.

As noted in Eickhoff et al., (2012) uncorrected P value thresholds and FDR corrected thresholds are not optimal.
Two new thresholding algorithms, Family-wise error and Cluster-level inference, have been added. Both
simulate random data sets using the same characteristics as your data set: number of foci, number of foci
groups, and subject sizes. The family-wise error method tracks the distribution of maximal ALE scores from each
permutation. The FWE corrected threshold is set to the ALE value that no more than a specified fraction of the
distribution exceeds that value. FWE thresholds are more conservative, so 5% of random studies, or P<0.05 is
recommended. When using cluster-level inference, the simulated data is thresholded using a “cluster-forming
threshold” using FDR or an uncorrected P value. GingerALE finds the contiguous volumes above the threshold,
“clusters”, and tracks the distribution of their volume. The cluster-level inference corrected threshold sets the
cluster minimum volume such that only, for example, 5% of the simulated data’s clusters exceed this size. We
generally use P<0.001 or FDR of 0.01 as a cluster-forming threshold and 0.05 for cluster-level inference. Cluster-
size thresholds are available when using threshold methods other than cluster-level inference, you can remove
clusters under a user-chosen size by using the “Min. Volume (mm?®)” setting (Fig. 3).

Whichever threshold algorithm you used, GingerALE will compile some statistics on the regions above the
threshold. The cluster statistics include volume, bounds, weighted center, and the locations and values at peaks
within the region. Anatomical labels from the Talairach Daemon (talairach.org) are given to the peaks as well as
volumetric label data for the clusters. If you are using MNI, coordinates are transformed using icbm2tal
(Lancaster et al., 2007). For analyses using FDR, a recommended cluster size is included in the statistics. This
volume is calculated using the false discovery rate and the total volume above the threshold. The resulting
minimum volume will remove any cluster that was smaller than the allowed false positives, leaving clusters that
should contain true positives. To facilitate network analysis, the cluster statistics include a table inspired by
Lancaster et al., (2005) with the number of activations from each foci group that fall within each cluster.

The final field in the GingerALE interface (Fig. 3) sets the file names of your output files. The prefix given here
will determine the base file name of all output files. GingerALE will usually create an unthresholded ALE score
image, an unthresholded P value image, a thresholded ALE image and two statistics text files. The preferences
(Fig. 6) allow choosing exactly which files are saved. A warning can be shown if any output files would overwrite
an existing file. All images are saved in NIfTI format (http://nifti.nimh.nih.gov), which can be read by a number
of functional neuroimaging software packages.




2.3 Contrast Analyses

To perform a contrast analysis and examine two different sets of foci for statistically significant differences in
convergence, you must first run separate ALE analyses on the two foci files. Then, create a combined text file in
which foci from both files are merged and run this “pooled” analysis. Make sure that experiments that appear in
both sets of foci are only reported once in the pooled text file. GingerALE can help make the pooled data set:
File > Save & Merge Foci. Once the pooled analysis is complete, you will need the 3 thresholded ALE images
that were created in each of those analyses.

To carry out a subtraction analysis, first select the
“Contrast Studies” radio button in the main GingerALE
window. Open the three thresholded ALE images using
@ GingerALE the File menu items: Open ALE Image 1, Open ALE

Image 2 and Open Pooled ALE Image. Now that the
required data sets are loaded, double check your
chosen settings for threshold method and value,
number of permutations, and output file names prefix,
Coordinate System  MN then click Compute.

SNGNS) GingerALE

Input Data

() Single Study  {*) Contrast Studies

Data Set 1 L_insula_ALE_pNO001 .
Contrast analysis compares and contrasts two ALE

. A :
e datasets. A conjunction image shows the similarity

Data Set 2 R_insula_ALE_pNOO1 between the datasets. The conjunction is created using
1392 Foci, 78 Experiments, 32376 mm? the voxel-wise minimum value of the input ALE images.
Pooled Data Sets LR insula ALE bNO1 Two ALE contrast images are created by directly

subtracting one input image from the other. This ALE
subtraction image does not take into account
differences between the studies. To correct for study
FDR pN 4] [o0.05 sizes (Eickhoff et al., 2011), GingerALE creates simulated
data by pooling the foci datasets and randomly dividing
them into two now groupings of the same size as the
Min. Volume (mm?) 0 original data sets. An ALE image is created for each new
data set, then subtracted from the other and compared
to the true data. After many permutations, we have a
Data Set 1 Output Name L_insula voxel-wise P value image showing where the true data’s
values sit on the distribution of values in that voxel. In
certain cases, a very small or even negative value could
Ready... (' Compute ) be significantly high on the distribution. To simplify

interpretation of ALE contrast images, they are
converted to Z scores to show their significance instead
of a direct ALE subtraction. Cluster analysis of contrast
images uses Z score values in the image statistics and
maxima.

2743 Foci, 156 Experiments, 107984 mm’*

Settings

P Value Permutations 5000

Qutput Files

Data Set 2 Output Name R_insula

Figure 4. GingerALE Contrast Interface

GingerALE saves the foci data of an ALE analysis in the output image’s header. This allows the contrast analysis
to load the foci data for each dataset out of the image file. GingerALE will show a warning if there are identical
foci groups in both datasets. This warning can be ignored if the same foci group is intentionally in both datasets,
for example if it has coordinates in both the left insula and right insula (Fig. 4). GingerALE tries to distinguish
between a single foci group present in both data sets and two distinct experiments by checking if the data is
duplicated within the pooled data set or not. Warnings will be shown if there are foci group from either of the
two input datasets that are not in the pooled data or vice versa. The contrast analysis is restricted to voxels that
were significant in at least one of the three input images.



Meta-analytic connectivity modeling (MACM) can be used to examine the functional connectivity of a specific
brain region (Robinson et al., 2010). MACM is a simple, easily adaptable, data-driven method that is especially
useful for identifying connections within an indirect network. This method can be performed using Sleuth and
GingerALE. First, acquire an anatomical seed ROI, and make sure it conforms to Sleuth’s image requirements of
square 1mm voxels and a maximum ROI volume of 10,000 mm>. Next, use Sleuth’s image search capability to
identify patterns of coactivation across the entire database. It's recommended to include the Experiment-level
search criteria of “Context: Normal Mapping” and “Activations: Activation Only”. Export your coactivation
coordinate results using “Export -> Locations (GingerALE)” menu item. Open the coordinates in GingerALE and
perform a meta-analysis as described in Section 2.2 to identify areas of convergence among the coactivation
coordinates. Further refinements to the method (Robinson et al., 2012) suggest including additional search
criteria, such as behavioral domain, to add context to the otherwise context-less, task-independent results. As
Sleuth’s database grows, so will the generalizability, robustness and power of this approach.

A number of files may be created during a single dataset ALE analysis:

* ALE Image: contains the unthresholded ALE values, one computed at every voxel in the brain. The file
name used to save this file will be your “Output Name Prefix” setting (Fig. 3) and the suffix “_ALE.nii"

* P Value Image: contains each voxel’s unthresholded P value. File name suffix: “_P.nii”

* Thresholded Image: ALE map threshold at a given & value. This is considered the final output image,
and is used as the input for contrast analyses. It has a variable file name, depending on the thresholding
method and value chosen. For example, when using FDR pN < 0.01, the suffix would be “_ALE_pNO1.nii".
It could also be “_ALE_p001.nii” or “_ALE_FWEO5.nii”, etc.

* Cluster Image: The first step in cluster analysis is identifying the contiguous non-zero regions in the
thresholded image. Each voxel in each region is given an integer value, according to which cluster it is in.
The clusters are sorted by size, with #1 assigned to the largest cluster. Suffix: “_clust.nii”

* Cluster Spreadsheet: An excel document with 10 columns of information about the result’s clusters:

(1) cluster number, with the largest at #1

(2) volume of cluster in mm?®

(3-5) x,y,z values of the weighted center of mass

(6) maximum ALE value observed in the cluster

(7-9) x,y,z values of the location of the maximum ALE value

(10) Talairach Daemon anatomical label associated with the peak coordinates
If your preferences are for a cluster analysis to contain all extrema, then columns 6-10 will be repeated
in a new row with information on each local maximum. Qutput suffix: “_clust.xls”

¢ Data History: A text file that contains all the parameters and output file names used in the analysis. It
also includes any additional information about the different stages of analysis, such as the FWHM value
range and the total non-zero volume in the thresholded image. It also includes an expanded cluster
analysis, with all of the information from the spreadsheet as well as cluster extent and a volumetric
Talairach Label analysis. File name suffix: “_clust.txt”

Contrast analysis compares and contrasts two datasets. For simplicity, these datasets will be referred to as A
and B. The results of the comparison is a conjunction image and cluster analysis:

* Conjunction Image: contains the regions that exist in both datasets. Specifically, this is the voxel-wise
minimum between two thresholded ALE images. So, this image is also a thresholded ALE image. The
output file will be named “A_conj_B_ALE.nii".

* Cluster Analysis: The cluster analysis saves three files: a cluster image, a cluster spreadsheet and data
history. These files contain the same type of results as those described in the single dataset analysis
above, but apply to your conjunction image. They will be named “A _conj B_clust.nii”,
“A_conj_B_clust.xls” and “A_conj_B_clust.txt”




When contrasting two datasets, GingerALE produces results for both directions of the contrast. Each of the
following steps will produce at least two files: one for A>B and one for B>A.

ALE Images: contains the unthresholded ALE values, one computed at every voxel in the brain.
GingerALE recreates the unthresholded ALE images of each dataset to create these direct voxel-wise
subtraction images. At this point, the A>B image is the same as -1 times the B>A image. The file names
used to save these files will be your “Output Name Prefix” settings (Fig. 4) and the suffix “_ALE.nii”

P Value Images: contains each voxel’s unthresholded P value. P values are generated through permuting
through random re-groupings of the modeled activation maps (Eickhoff et al., 2011). For more
information on this method, see Section 2.3. File name suffix: “_P.nii”

Thresholded Images: contains Z-score images for each voxel above the threshold. It's possible with
unequally sized datasets to find an area with negative ALE values to have significant convergence. To
ease interpretation of the thresholded images, GingerALE switches from ALE maps to Z score images
computed from the P value images. The file name suffix depends on the threshold used.

Cluster Analyses: The cluster analysis saves a total of six files: a cluster image, a cluster spreadsheet and
a data history for each of the two directions of the contrast. The particulars of each of these files can be

found above earlier in this section when describing single datasets. The only difference is now the

cluster analysis is using Z score images instead of ALE images. Suffix: *

Once the thresholded map has been created, you'll
need an anatomical underlay in order to view the
meta-analysis results in context. We distribute two
templates in Talairach space (one general file and
one to be used specifically by AFNI) and one MNI
template (Fig. 5) on GingerALE's website
(brainmap.org/ale). Although our .nii files are
compatible with most medical image viewing
software, we suggest using Mango to view your
meta-analysis results (rii.uthscsa.edu/mango). After
installing Mango, here are some steps to view your
results:

a) Open = Open Image - select the Talairach
template file (Colinl.1.nii) or the MNI
template file (Colin27_T1_seg_MNlL.nii)
from GingerALE’s website, depending on
the space in which your meta-analysis was
performed.

b) In image window that pops up, click on File
—-> Add Overlay and select the thresholded
results image that you created in
GingerALE. It will be named after the
thresholding method and value that you
chose. (E.g. * pNO1l.nii, * p001.nii,
* FWEOQ5.nii, etc.) This overlays your
functional meta-analysis results on top of

4
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Figure 5. Anatomical underlay in Mango



the anatomical template.

c) In the image window, choose Edit - Update Image Range to make sure that all of your results are being

shown. (Very important!)

d) To view anatomical labels of your current location in brain space, as well as the coordinates, select the
button with a graph icon just to the right of the button with a “T” icon in the Mango small window,
move your cursor down until the globe icon is selected, then select your desired anatomical atlas from
the dialog window that appears. Anatomical labels and coordinates will then appear in top of the small
Mango window. This is Mango’s “World Space” setting that reads the reference space in the image’s

header.

e) To change the color map, go to the smaller rectangular window and click on the red box on the left side,
move your cursor down to the next red box, move to the side text box that pops up, move to “Color
Table”, then click on your preferred color option. Red-to-Yellow and Spectrum are our favorites for
GingerALE results. Integer images, such as Cluster images or Foci images, should use the Spectrum

color map.

3 Menu Iltems

3.1 Preferences

The preference window shows the relevant settings for
performing ALE calculations and saving output files. It is
under the GingerALE menu on Macintosh computers and
under the File menu otherwise. Shortcut: ;

Coordinate Space: A radio button is available to select
which standard space the meta-analysis should be
performed in: Talairach or MNI.

Mask Size: When a foci file is opened, the coordinates are
compared against a mask defining the outer limits of
Talairach (or MNI) space. A pop-up window will appear if
any of your coordinates are located outside of this mask.
The ALE analysis will proceed after this step without any
intervention on your part. However, any coordinates
located outside of this mask will not be omitted from
subsequent analysis and might possibly yield strange
activations on the border of your mask that do not appear
to have a center of mass.

Normally, finding coordinates outside of the mask will occur for less than 3% of your total foci (or even lower
since implementing the Lancaster transform instead of the Brett transform).
outside of the mask is sometimes due to author error (e.g., missing negative sign, inverted coordinates, etc.).
You can often spot this type of error and correct for it manually. For example, if a coordinate is listed as being
located in the occipital cortex, but the given y value is positive and extends outside of the Talairach mask, then

.6 GingerALE Preferences
Coordinate Space: @ Talairach O MNI
Mask Size: (®) More Conservative (Smaller)

() Less Conservative (Larger)

ALE Method: O Eickhoff (HBM, 2009)

(® Turkeltaub Non-Additive (HBM, 2012)
FWHM values are subject-based (Eickhoff, 2009)

p

Additional FWHM (mm): () None O

() No Sub-Maxima/Minima

Cluster Analysis Peaks: (®) All extrema

Output Directory: Change... )

~/Desktop/

Save Output Files for:

M ALE Image ™ Cluster Image

M P Value Image ™ Cluster Spreadsheet

M Thresholded Image M Data History
Warn me about:

) Foci Outside Mask [ Overwriting Files

Figure 6. GingerALE Preferences

we recommend that you change the y value from positive to negative before proceeding with ALE.

Finding coordinates located



Two options are available for your mask size, a smaller mask or a larger mask. Typically, we use the smaller
mask for meta-analyses of functional imaging studies. The larger mask is available for VBM meta-analyses
because many reported coordinates in these studies are located on the outside of the brain. We slightly
enlarged the mask for these meta-analyses so as to include

more foci located at the boundaries of Talairach or MNI space. 86C mask_diff.nii

File Edit View Analysis ROl Image Plugins Window

If you have a large number of outlying foci that you do not
want omitted from your meta-analysis, then you can select
the option of “Less Conservative (Larger)”. This option will
slightly increase the default mask size, thus including a wider
range of coordinates. An image of the difference between the
two mask files for the Talairach template can be seen in
Figure 7. In this difference image, the white areas denote the
extra voxels included when using the larger (less conservative)
mask file. Please note that if you use this larger mask, some of
your resultant ALE clusters may appear to be located outside
of the brain when viewed on the Talairach or MNI anatomical
templates.

ALE Method: Here, you may choose to use the ALE algorithm
described by Eickhoff et al. (2009) or implement the small
correction to minimize within-experiment effects described by
Turkeltaub et al. (2012). In addition, since both of these
techniques utilize automatically determined FWHM values,
we provide an option here for advanced users to implement
an additional manual FWHM “fudge factor”. Please note that
this parameter should be left as “None” for standard analyses.

Figure 7. Difference Between Mask Size Options

You may also choose if you want the coordinates of any resultant ALE clusters to be reported for all submaxima
in a single ALE cluster (“All extrema”) or only one coordinate for the maximum ALE statistic in that cluster (“One
extrema”). Choosing the former option is very useful for large ALE clusters that extend over many different
areas of the brain.

Output Files: Lastly, you may specify the output directory for all GingerALE output files and which files you want
to be saved. Further description of the output files can be found in Section 2.5.

Warnings: what your preference is for pop-up windows about boundary foci and overwriting files.

This menu item loads in a text file of coordinates into GingerALE. The format for this file should be three
columns of numbers (x,y,z coordinates), separated with tabs or spaces. If you created your foci file in Sleuth, the
file starts by indicating the standard brain space, and subsequent experiments will be separated by a line break
and delineated by first author name, year, and experiment name (“//” comments these descriptors out so that
they will not be read by the ALE algorithm). Between the commented experiment name and the list of
coordinates, you should also include a line that details the number of subjects for that group of foci. Shortcut: F

Contrast analyses use the thresholded ALE images from individual analyses. For more on how subtraction
analysis works, see Section 2.3. Open ALE Image 1, Open ALE Image 2 and Open Pooled ALE Image menu items
let you select the files for your first, second and pooled datasets. For more on creating pooled datasets, see just
below in Section 3.4. These menu items are only enabled when in Contrast Analysis mode. Shortcuts: 1, 2, 3



3.4 Merge & Save Foci

This tool will combine the foci from Data Set 1 and Data Set 2 into a pooled data set. It automatically merges
datasets by removing the second copy of experiments found in both data sets. Duplicated experiments should
be removed as to not give extra weight to those studies. Be careful, it’s possible for different experiments to
have identical foci be incorrectly removed; so double-check your data! It's also possible for a study to be
intentionally included into both datasets, depending on your contrast analysis. So human verification is highly
recommended for this step. This tool is enabled when both 1&2 datasets are loaded. Shortcut: M

3.5 Save Data History

This menu item allows you to save a text output that summarizes your ALE meta-analysis at any point in the
procedure. If you are in an early stage of the analysis, very little will be in the data history; possibly only
information on the current mask. For more information on the Data History file, see Section 2.5. Shortcut: S

3.6 Export Foci Image

This menu item creates an .nii image of your foci file. In this image, each coordinate point is assigned a value. No
blurring of the coordinate points is performed in this export — this step is simply intended as a way to view your
coordinates in standard space. The value assigned to each coordinate point matches the experiment number of
your foci file. Remember, different experiments are defined in a foci file simply by including a line break
between the groups of foci. By assigning values in this way, it is easy to set each experiment number to a
different color in your image viewer so that you can identify the paper and experiment for each coordinate point
as you scroll through the brain. If 2 identical coordinate locations are included in different experiments, then the
value assigned to that voxel will be n+1, where n equals the number of total experiments. This is done so that
coordinates that are listed in multiple experiments won’t be incorrectly identified as in only one experiment and
so these multiple activation coordinates can be found on the resultant output image.

3.7 Convert Foci

This menu item uses a dialog window as seen in Figure 8 to guide you through the conversion of your
coordinates from MNI space to Talairach space and vice versa. You are given options for selecting your input file
of coordinates, the transform you would like to use, and the name and location of your output file.

There are 8 coordinate transforms included in GingerALE. 006 Convert Foci

Input File: coords_MNLtxt ( Choose )

The first three transforms convert coordinates from MNI

space to Talairach space using the Lancaster transform, af Fock & Experiments

icbom2tal. This transform is broken into 3 options, based on Choose Transform: | MNI (SPM) to Talairach | 3]
what software you used for spatial normalization of your '
data (SPM, FSL, or Other): Output File: coords_Tal.txt Choose

( Transform! )

(1) MNI (SPM) to Talairach
(2) MNI (FSL) to Talairach
(3) MNI (Other) to Talairach

Figure 8. Transforming Coordinates between MNI
and Talairach Spaces

The second three transforms perform the corresponding transforms from Talairach space to MNI space using
the Lancaster transform. Again, this transform is broken into 3 software options:

(4) Talairach to MNI (SPM)
(5) Talairach to MNI (FSL)
(6) Talairach to MNI (Other)



The last 2 transforms are reproductions of the Brett transform, mni2tal. Two options are given for the Brett
transform, one for converting from MNI space to Talairach space, and the other for converting from Talairach
space to MNI space:

(7) Brett: Talairach to MNI
(8) Brett: MNI to Talairach

Although the BrainMap database no longer supports use of the Brett transform, we feel it is still important that
we include it in our software. If one of the studies included in your meta-analysis generated its coordinates by
using SPM for spatial normalization and published those coordinates after conversion using the Brett transform,
then we recommend that you “un-Brett” the published coordinates using the above transform “Brett: Talairach
to MNI” and then proceed with the Lancaster transform “MNI (SPM) to Talairach”. This will correctly move your
coordinates into the Talairach space.

3.8 Help Menu

About GingerALE: This menu item contains basic information

about GingerALE, such as the homepage, version number, and @ GingerALE File Tools Help
copyright date. On Macintosh computers, this menu item is
under the GingerALE menu. Otherwise, it is in the Help menu. Figure 9. GingerALE’s Main Menus

Check for Updates: This menu item will check the BrainMap website to see if you have the latest version of
GingerALE.

Show Manual: This menu item will show the current manual for GingerALE (this document). An internet
connection is necessary for this menu option.

Show Read Me: This menu item will show the current readme file for GingerALE. The readme file contains
information about installation and version changes. An internet connection is necessary for this menu option.

Show License: This menu item will show the current license information for GingerALE. An internet connection is
necessary for this menu option.

4 Citing GingerALE

If you use GingerALE in your research, please acknowledge our previous work in any resultant publication.

For research using a contrast analysis:
Eickhoff SB, Bzdoc D, Laird AR, Roski C, Caspers S, Zilles K, Fox PT. Co-activation patters
distinguish cortical modules, their connectivity and functional differentiation. Neuroimage 57,
938-949, 2011.

For research using GingerALE 2.x:
Eickhoff SB, Laird AR, Grefkes C, Wang LE, Zilles K, Fox PT. Coordinate-based activation likelihood
estimation meta-analysis of neuroimaging data: A random-effects approach based on empirical
estimates of spatial uncertainty. Hum Brain Mapp 30, 2907-2926, 2009.

and
Eickhoff SB, Bzdok D, Laird AR, Kurth F, Fox PT. Activation likelihood estimation revisited.
Neuroimage 59, 2349-2361, 2012.

and



Turkeltaub PE, Eickhoff SB, Laird AR, Fox M, Wiener M, Fox P. Minimizing within-experiment and
within-group effects in activation likelihood estimation meta-analyses. Hum Brain Mapp 33, 1-13,
2012.

For research using False Discovery Rate threshold:
Laird AR, Fox M, Price CJ, Glahn DC, Uecker AM, Lancaster JL, Turkeltaub PE, Kochunov P, Fox PT.
ALE meta-analysis: Controlling the false discovery rate and performing statistical contrasts. Hum
Brain Mapp 25, 155-164, 2005.
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